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1 What’s New in 5.14.03? 
Overview 

This section provides information about the new features in this release. Several 
enhancements have been made to this version and a few new exciting features have 
been added. 

1.1 Pictures in markups 
The markup functionality has been extended to support pictures. This is useful for 
adding complementary information to markups in a station viewer.  

 

1.2 Connect to virtual controllers in the Online tab 
Virtual controllers that are running on your computer, but are not part of your 
RobotStudio station, can be connected in the Online tab. The function is added to 
support application developers when creating add-ins to RobotStudio, the IRC5 
controller or the FlexPendant. 
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1.3 New robot models – IRB1520ID 
The new arc welding robot IRB 1520ID is included in RobotStudio 5.14.03 and fully 
integrated. 

 

1.4 New version of SLP Distributor 
There is a new version of SLP Distributor used for the Network license editions of 
RobotStudio. The new version supports manual activation of network licenses. 

1.5 RobotStudio Update blog available in RobotStudio 
The RSS feed with Robotics News, available in the Help section of the File page, has 
been changed to point to the RobotStudio Update blog.  

 
The blog is also available from the ABB Robotics software product pages at 
http://www.abb.com/roboticssoftware. 

 

 

http://www.abb.com/roboticssoftware
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1.6 View activation keys 
The activation keys are now visible in the View Licenses dialog. To view them go to 

File  Help  Manage Licenses  View installed activation keys 
 

 

1.7 New ACIS version 
The CAD kernel used has been upgraded to version R22 SP1. For a detailed list of 
changes, see http://doc.spatial.com/index.php/ACIS_Release_Notes 

 

1.8 Link to Developer Center 
The new web portal for Robotics application developers Developer Center can now be 
accessed from a link in the Help menu of the File page (File  Help  Developer 
Center). The Developer Center web portal is also available at  
http://developercenter.robotstudio.com/ 

 

1.9 Link to ABB Robotics Software Product pages 
The link to the Online Community is redirected to point to the ABB Robotics Software 
Product pages at http://www.abb.com/roboticssoftware. 

 

  
 

 

http://doc.spatial.com/index.php/ACIS_Release_Notes
http://developercenter.robotstudio.com/
http://www.abb.com/roboticssoftware
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2 What’s New in 5.14.02?  
Overview 

This section provides information about the new features in 5.14.02. 

2.1 Heat Prediction Tool 
The complexity of determining the need for cooling fans for axis 1 or/and axis 2 motor 
or not depends on several parameters. The limit for how hard the motors can run 
depends on both torque, revolution, and also the ambient temperature and therefore its 
not a simple task to put that information in e.g. a table to get reliable facts to make the 
decision for each and every specific installation. 

Therefore has a “Gearbox Heat Prediction Tool” been developed and added to 
RobotStudio as an Add-In application. The tool does not require a premium license. 

2.2 External Axes Wizard 
Delivered as a separate Add-In available form the RS Community content sharing 
website. Premium license required. 

http://www.robotstudio.com/community/ 

2.3 New robot models – IRB5320 
The IRB5320-1500 and IRB5320-2000 are now supported and included in the 
installation. 

2.4 Network license 
RobotStudio 5.14.02 is prepared for network licensing which soon will become 
available for schools and ABB selected partners. Further information will be 
communicated on the RS Community website. 

http://www.robotstudio.com/community/ 

http://www.robotstudio.com/community/
http://www.robotstudio.com/community/
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3 What’s New in 5.14.01?  
Overview 

This section provides information about the new features and in this release. 

3.1 Online Monitor 
The parameters for defining update rate, warning and error levels for joint limits and 
singularities has been added to the RobotStudio Options pages. 

 

3.2 AutoPath 
The AutoPath feature can be used to create a path based on the edges of the surfaces of 
a part. The function only allows a path to be created along adjacent faces. The 
parameter that defines the maximum distance between two faces to be considered 
adjacent has been  added to the RobotStudio Options page. 

 

3.3 Collada import and export 
RobotStudio can now import files in the format Collada version 1.4.1 (.dae) using the 
function Import Geometry. Objects can be exported in the Collada format using the 
function Export Geometry. The static geometry of an entire station can be exported in 
the collada format by selecting the station node of the Layout browser and selecting 
Export Geometry. 
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3.4 Measurement markup 
The x,y,z values of a measurement are displayed in a markup together with the total 
distance. 

 

3.5 Access Level ALL no longer needed of input signals 
Signals of a VC no longer need to be defined to have Access Level = ALL in the I/O 
Configuration database to change its values from RobotStudio. It is sufficient to have 
them defined with Access Level = DEFAULT. 

3.6 Preview image of Pack & Go files 
A preview image of the station contained in a Pack&Go file will be displayed in the 
preview pane of Windows Explorer in Windows 7. 
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3.7 New robot models – IRB5300-12 
The IRB5300-12 (the so-called door opener) is available in RobotStudio 5.14.01 
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4 What’s New in 5.14?  
Overview 

This section provides information about the new features in RobotStudio 5.14. 

4.1 Microsoft Office 2010 Fluent User Interface 

 

Fluent UI 

The RobotStudio 5.14 user interface is redesigned and now uses the Microsoft Office 
Fluent user interface (UI). Introduced in the RobotStudio 5.11, the Fluent UI is 
designed to make it easier for people to find and use the full range of features that 
RobotStudio provide, and to preserve an uncluttered workspace.  

The Ribbon 

The ribbon, part of the Fluent UI, was designed to optimize key RobotStudio scenarios 
to make them easier to use. The ribbon provides quicker access to all the commands in 
RobotStudio and allows for easier future additions and customizations. You can make 
your favorite commands available in the quick access toolbar, embedded in the title bar. 
To help maximize the space of the graphical viewer, the ribbon can be hidden. 

Backstage View 

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the 
ribbon. The Backstage view, which can be accessed from the File menu, helps you find 
frequently used features for managing RobotStudio files. (The File tab replaces the 
RobotStudio Button and File menu that were used in earlier releases of RobotStudio.)  
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4.2 Activation and Licensing 

Version independent activation key: RobotStudio 5.x 

Starting with RobotStudio 5.14, the activation key that activates RobotStudio 5.14 will 
also activate all future versions (both major and minor) of RobotStudio 5. This is 
indicated by the version of the installed license key in RobotStudio. The version 
displayed in the license information dialog is now 5.x. 

 

4.3 General 

Document Manager References 

References to files and folders can be added to a station through the Document 
Manager. Referenced folders can optionally be included in the Pack and Go file. There 
is also an option to completely embed a file in the station. 

 

New Robot Models 

Simulation models for the following new robots have been added to RobotStudio 

 IRB2600ID (15kg/1.85m) 

 IRB2600ID (8kg/2.0m) 

 IRB460 

 IRB760 
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Station name in title bar 

The name of the currently opened station has been added to the title bar. 

 

Improvements of CAD based path generation (AutoPath) 

The function ’Path from Curve’ for automatic creation of path based on a curve, has 
been improved. It is not longer required to have a curve prepared as it can work on the 
edges of a piece of geometry. Of course, if a curve is available, it can be used for the 
path generation as before. The user interface has been simplified and advanced options 
for angle tuning, approach and depart targets removed. Also, a preview of the path is 
available to indicate what the result will be before the command is executed.  

Tuning of targets can be done through the new Reference Frame available in the Set 
Position and Rotate tools. Approach and depart targets can be created using the regular 
copy/paste functions in combination with the tuning feature. The function has been 
renamed to AutoPath to reflect the re-design. 

  

Online Monitor 

The Online Monitor can be described as a virtual web camera that monitors the 
connected robot and visualizes its movements. The graphical view that shows the robot 
model is updated with the true robot position every second. If the robot is in a singular 
position or at a joint limit you will get an indication in the view. Only TCP robots will 
be shown as external axes are not supported. 
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Adjust Robtargets 

The Premium feature Adjust Robtargets allows programs that has been programmed 
with the wrong TCP (tooldata) or work object (wobjdata) to be corrected. The joint 
angles of the robot will remain the same.  

 

Accelerated simulation 

An option to run the simulation as fast as possible has been added to the Simulation 
Accuracy section of the RobotStudio options. With this option selected, RobotStudio 
will fire the next time step as soon as the calculation for the previous one is completed. 
The predicted execution times for the Virtual Controllers will not be affected. 

 

Station Viewer Improvements: Acceleration and Seek Bar 

The simulation replay of the Station Viewer can now accelerated up to 200% of the 
normal execution speed. It is also possible to reduce the time or even play the 
simulation backwards. In addition, a seek bar has been added that shows simulation 
progress and allows the simulation to be started at a particular point. 
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Simulation Step / Pause / Resume 

A simulation can now be stepped forward one tick at the time. First, start the simulation 
as usual by pressing the Play button. Then, you can pause the simulation by pressing 
the Pause button. When paused, the Play button will be renamed to Resume, and the 
Pause button will be renamed into Step. Now, the simulation can be stepped forward 
one time step (tick) at the time by pressing the Step button. 

Before starting the simulation the Play button is enabled. When the simulation is 
running, the Pause button is enabled. When paused, the Play, and Pause buttons are 
renamed, Resume and Step, respectively, see below. 

     

ScreenRecorder support for Microsoft Windows Media format 

Support for Windows Media version 8 and 9 has been added to the Screen Recorder. 
In addition, movies can be recorded using the H.264 / MPEG-4 encoder that creates 
high-quality recordings with a high compression ratio. The AVI format is still available 
and allows the selection of any available codec on the computer. 

 
NOTE! 
The Microsoft Windows Media and H.264 encoders are only available for Windows 7, 
not for Windows XP. 
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Transparent textures 

To simply modeling and increase realism, support for transparent textures has been 
added to RobotStudio. The textures are applied using the Graphical Appearance tool. 
The feature supports textures in .PNG format. 

 

 

Target Reference Frame 

The reference frame of a target has now been exposed in RobotStudio. Until now, it has 
only been available in ArcWelding PowerPac. The target reference frame allows a 
target to be offset relative to the original position. This is useful if the targets have been 
created using a CAD-model and it is required to offset the target position to compensate 
for the robot tool. The Reference Frame is available in the Set Position and Rotate 
tools 

 

Improved performance for Configurations and AutoConfig  

The different ways a robot arm can use to reach a certain target is controlled by the 
confdata in RAPID and can be set using the Configurations tool in RobotStudio. 
The performance of the calculation of the available arm configurations are now done 
directly by the virtual controller, which gives a dramatic increase in performance. The 
improved performance can be seen when using RobotWare 5.14. 



What’s New 
RobotStudio 5.14.03 

 
© Copyright 2012 ABB All rights reserved 16 
 

Collision Detection performance improved.  

The Collision Detection computation has been improved to make use of multiple CPU 
cores, if available, and uses the SSE (Streaming SIMD Extensions) instruction set for 
best performance. 

Nine decimals in generated RAPID code 

The number of decimals used for specifying the position and orientation data of 
generated robtargets, tooldata, and wobjdata are now limited to nine. This 
will increase readability of the generated RAPID code. Accuracy is not affected since 
the data is declared in RAPID as num (single precision) that uses the eight first 
decimals. 

Markups 

A markup is a text box displayed in the 3D graphics. It can be used to highlight areas of 
interest. Markups become part of the Station Viewer. 

 

AutoConfig options 

New options related to AutoConfig 

 Verify. Verifies existing configuration  

 Reset. Marks current configuration as unverified to enable for optimization using 
AutoConfig  
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Signal Analyzer 

Signals to be analyzed are defined in the Signal Setup tool for viewing and analysis in 
the Signal Analyzer. The tool allows robot performance tuning and signal debugging.  

The table below lists the signals that can be analyzed and their dependency on 
RobotWare.. 

Signal name RW availability 
Controller Signals / <system name> / EventLog 
 <domain> Any RW version  
Controller Signals / <system name> /  Mechanical Units / I/O System 
 <all signals> Any RW version 
Controller Signals / <system name> / Mechanical Units / ROB_x / Joint 
 J1-J6 Any RW version 
 Near Limit Any RW version 
Controller Signals / <system name> / Mechanical Units / ROB_x / Target 
 Fine Point Any RW version 
 Target Reached Any RW version 
Controller Signals / <system name> / Mechanical Units / ROB_x / TCP 
 Maximum Linear Acceleration in World1 RW version  5.14 
 Orientation Q1-Q4 Current Workobject RW version  5.14 
 Orientation Speed in Current Workobject RW version  5.14 
 Pos X, Y, Z in Current Workobject RW version  5.14 
 Robot Configuration cf1, cf4, cf6, cfx RW version  5.14 
 Speed in Current Workobject RW version  5.14 
 Total Motor Power RW version  5.14 
Smart Components 
 <all signals> <no RW needed> 

 

The Signals are visualized in the graph below.  

 
Using the Signal History tool, signal recordings can be exported to Excel, renamed, or 
deleted. 

NOTE! 
The maximum number of signals that can be exported is limited to 26. 

                                                   
1 The signal ’Maximum Linear Acceleration in World’ provides the maximum acceleration of the 
current move instruction. 
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RAPID Profiler 

The new RAPID Profiler is a tool for measuring and analyzing procedure execution 
times of the robot program. It is a Premium feature that can be used to identify the 
critical procedures that offer great potential for cycle time reduction. Special attention is 
paid to Wait-instructions and MultiMove synchronization semaphores. Reducing 
waiting times is the obvious way to reduce the program execution time. 

 
 

 
NOTE! 

 The Spy function does not produce useful output for systems based on the 
RobotWare option CAP (Continuous Application Platform). This is the case for e.g. 
systems with ArcWelding. This affects the RAPID Profiler that analyses the log 
generated by the Spy function. 

 For accurate results, the last move instruction of all procedures should be a fine 
point. Otherwise the estimated time for that procedure will be underestimated. 

External axis interpolation 

Defines optimal external axis value with respect to robot TCP 

 



What’s New 
RobotStudio 5.14.03 

 
© Copyright 2012 ABB All rights reserved 19 
 

4.4 Smart Component Improvements 

Smart Component: LogicExpression 

A gate whose output is determined by a logic expression. Supports logic operators 
AND, OR, NOT and XOR. Advanced gates can be easily created using the 
LogicExpression gate. The overall complexity of a smart component is reduced since 
the gate logic can be handled by one base component. 

Example: output = input5 XOR (input1 AND input2) OR (NOT input3) 

Smart Component Viewer Filter 

The objects of the SmartComponent viewer can now be filtered to reduce the 
complexity. 

 signals 

 properties 

 only connected components 

Property Detectable added to graphical objects 

Allows graphical objects to be made invisible to SmartComponent sensors 

4.5 ScreenMaker Improvements 

Language Support 

ScreenMaker supports the same set of languages that RobotStudio supports. The 
languages are applicable for the User Interface which includes the ribbon and dialogs 
and not for the controls and its properties . 

ScreenMaker Templates 

ScreenMaker now includes the three templates Basic, Advanced and Extended, which 
represent typical uses of ScreenaMaker.  

Launch Virtual Flexpendant after deploying 

The new option to automatically launch the Virtual FlexPendant after the current 
ScreenMaker application have been deployed is available in the ScreenMaker 
properties. 

Access of shared data 

Shared RAPID data can now be accessed using ScreenMaker 



What’s New 
RobotStudio 5.14.03 

 
© Copyright 2012 ABB All rights reserved 20 
 

Conditional Trigger Control 

A new control for configuring the execution of events based on condition. The 
following table describes the conditions and datatypes supported  

Condition RAPID Signals Application Variables 
AND bool NA bool 
OR bool NA bool 
XOR bool NA bool 
NOTEQUAL Any Type Any Type Any Type 
EQUAL Any Type Any Type Any Type 
GREATER num, dnum num, dnum num, dnum (0/1) 
LESSER num, dnum  num, dnum num, dnum(0/1) 

ScreenMaker Doctor detects missing RAPID and Signal data 

The ScreenMaker Doctor now detects missing RAPID and Signal data that has been 
bound in the ScreenMaker project but does not exist in the connected controller. The 
ScreenMaker project must  be connected to the controller to detect RAPID and Signal 
data. The ScreenMaker Doctor does not detect actions that are defined as part of events. 
For example: If an action has been defined to Read Rapid Data into Application 
Variable.  

Increment / Decrement control 

A new control for incrementing and decrementing a NUM/DNUM. 


